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About This Manual 
This manual is divided into the following three sections. 
  
• SECTION 1: Getting Started with NTRadmin 

This section covers the core functionality of NTRadmin.  These are the things that every 
user will need to know in order to use NTRadmin. 

 
• SECTION 2: Remote Network Administration with NTRadmin 

This section describes any other features related to administering your network with 
NTRadmin.  The features relevant to you will depend on your own specific needs, so we've 
put these features into a separate section in order to make a clear distinction between what 
you need to know and what you may want to know. 

 
• SECTION 3: Additional Features of NTRadmin 

This section describes any features of NTRadmin that do not directly relate to administering 
your network.  These are, of course, very useful features, but we've put them into a 
separate section in order to clearly distinguish them from the main use of NTRadmin, which 
is network administration. 
 

• SECTION 4: Appendices 
This section contains technical information or greater detail on features already described in 
the main manual. 

 
Sections 2 and 3 are written with the assumption that you have read Section 1 or are already 
familiar with the core functionality of NTRadmin.  By dividing the document in this way, we hope 
to make it easier for you to find the information that is most useful to you. 
 
We at NTRglobal want this manual to be as useful, complete and accurate as possible so if you 
have any suggestions for improvements to either the style or content, please do not hesitate to 
contact us at ntrdocumentation@ntrglobal.com. 
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SECTION 1 
Getting Started with NTRadmin 
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What is NTRadmin? 

What Does It Do? 
NTRadmin is an advanced and innovative system with which to remotely administer your 
network's computers from any computer connected to the Internet. 
 
With NTRadmin, you can launch tasks on your whole network, a single computer, or selected 
computers within your network. Not only is this more convenient than administering every 
computer directly and separately, it will also help you to dramatically cut the time that you spend 
on administration, to maintain more consistent configuration across your network, and to 
investigate, report on, or change the configuration of any computer within that network. 
 
Here are just some of the time-consuming and difficult tasks made quick and easy by 
NTRadmin: 

• Installing software to the whole or a part of your network. 
• Checking or modifying a computer's configuration. 
• Distributing files across your network. 
• Sending messages for display on the screens of your network's computers. 

 
And, in each case, you can choose the computer or computers on which you want to take the 
action. 
 

How Does It Work? 
Each NTRadmin administrator (the person that wants to administer their network with 
NTRadmin) first creates a small installer-program that they can then install on each computer 
than they want to administer with NTRadmin. (This is the last time that the administrator will 
need to perform the same action separately on more than one computer within their network.)  
The administrator can install this program to their whole network, selected computers within 
their network, or even to computers from several different networks. The computers enabled for 
administration with NTRadmin will then be listed in the NTRadmin interface. As NTRadmin is a 
web-based service, the administrator will then be able to administer the enabled computers 
through a standard web-browser from any computer with an Internet connection. 
 

System Requirements 
NTRadmin is designed and prepared to function under the following minimum technical 
requirements, which are the responsibility of the customer. 
 
Administrator Computer 
• Microsoft Windows NT, 2000, 2003, XP, or Vista  
• Internet Explorer 5.5 or later 
• 128 MB RAM 
• 1 MB free disk space 
• Internet connection (33.6 Kbps minimum, 256Kbps recommended) 
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• Open ports (recommended): 25 or 110 (configurable) 
 
Client Computers 
• Microsoft Windows NT, 2000, 2003, XP, or Vista 
• 128 MB RAM 
• Internet Explorer 5.0 or later 
 
Mobile 
• Pocket PC 2003 or later, 2nd Edition 
• Windows Mobile 5.6 Pocket PC Edition 
• 256 KB disk space 
• GPRS connection (3G recommended) 
 
To remotely install NTRadmin on client computers on your network, you must meet further 
requirements. For more information, see “Automatic Installation” on page 12. 
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Using NTRadmin for the First Time 
Logging In 
You can log in to NTRadmin by going to the NTRadmin homepage on the Internet at 
http://www.ntradmin.com and entering your user name and password. If you forget your 
password, you can request a reminder e-mail.  
 

The NTRadmin User Interface 
The NTRadmin user interface allows you to access all the tools you need to set up and 
administer your network. When you log in, the system displays an overview of your network, 
including information on the number of installed computers, the number of computers online, 
and user messages. It lets you easily view a list of all client computers installed on your network 
so that you can start administering them immediately. 
 

 
 

Item Description 
A Information Bar – Displays details of the user currently logged in to NTRadmin. 

Allows you to modify your user profile and password, request support, and log out of 
the application. 

B Tools Menu – The tools menu allows you to manage NTRadmin installations on client 
computers, define jobs, organize files, read messages, interact with the NTRadmin 
community, and manage other settings related to NTRadmin. 
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C Computers List – Allows you to work with client computers on which you have 
installed NTRadmin. 

D Resizing Bar – Allows you to show, hide, or resize the tools menu or computers list. 

E Tabbed Workspace – Displays the main workspace. Each time you select a tool from 
the tools menu or a computer from the computer list, a new tab is added to the 
workspace that allows you to work with NTRadmin. 

 

Information Bar 
The information bar provides you with information about your NTRadmin session. It displays 
your user name, user ID, and the time you logged in. You can use the information bar to log out, 
change your profile, or request support from NTRglobal. You can also download and view the 
NTRadmin user guide  
 
Changing your Profile and Password 
Once you are logged in to NTRadmin, you can change your profile and password at any time. 
Your profile contains information such as your display name, e-mail address and language 
preferences. 
 
If you change the e-mail address associated with your profile, the next time you log in, you must 
use your new e-mail address. 
 
To change your profile 
1. Choose User Profile > Modify Profile 
2. Edit the information for your profile. 
3. To save your settings, choose Send. 
 
To change your password 
4. Choose User Profile > Change Password 
5. Enter your current password and the new password you want to use. 
6. To save your settings, choose Send. 
 

Tools Menu 
The tools menu is your main starting point when you need to complete a task in NTRadmin. The 
tools are organized according to the type of task; some tools offer a number several choices to 
help you complete a task. 
  

Tool Description 
Favorites Gives you quick one-click access to the computers you administer most 

frequently. 

Installation Allows you to install NTRadmin on remote computers, either manually or 
automatically over the network. 

Jobs Allows you to manage jobs and bots. You can use bots to automate IT 
tasks. 

File Management Allows you to upload and manage files in NTRadmin. You can distribute 
files by using bots. 
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Messages Allows you to view system messages and messages sent by users. 

Community Allows you to view and participate in NTRadmin forums, receive 
community support, and submit proposals for new bots. 

Settings You can configure your account settings, add or disable administrators, 
share computers, and change remote control authorization settings for 
computers in your computer list. 

 
Hiding the Tools Menu 
If you want to increase or decrease the size of the workspace, you can either completely hide 
the tools menu or resize it to the size you want using the resizing bar.  
 
To resize the tools menu 
• Hold and drag the resizing bar to the desired position. 
 
To hide or show the tools menu 
• Click the shaded arrow on the resizing bar. 
 

Computers List 
The computers list shows a list of all the computers on which you have installed NTRadmin and 
which you can administer remotely. If you have a large number of computers to manage, you 
can organize your computers into groups. 
 
To start working with computers in your network, you must select an individual computer or a 
group of computers from the computer list. Once you have selected a computer, you can 
perform any number of administrative tasks such as shutting down the computer, starting a 
remote control session, or running a Bot. 
 

Tabbed Workspace 
The workspace allows you to work with the different tools you select from the tools menu. Each 
time you select a tool, a new tab is added to the workspace. The Home tab is always displayed 
and shows an overview of your network  
 
Managing Tabs 
You can open a maximum of ten tabs in the workspace. If the maximum amount of tabs is 
reached, the system alerts you. To use another tool, you must close an open tab. 
 
To close a workspace tab 
• Click the Close Tab button on the right side of the tab. 
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Installing NTRadmin on Client Computers 
To install NTRadmin on client computers, you can use one of two methods. You can install the 
service automatically over the network, or you can install the service manually by creating and 
downloading an installation file that you subsequently distribute to your computer users. 
 

Automatic Installation 
An automatic installation allows you to install NTRadmin on client computers over the local area 
network (LAN). You configure the installation file in NTRadmin and select the computers on 
which you want to install it. NTRadmin is automatically installed over the network. 
 
Before performing an automatic installation, make sure the following requirements are met.  
• You must have administrator privileges for the domain in which want to install NTRadmin. 
• You must have administrator privileges for the computer you use to perform the installation. 
• You must have write permissions for the “Windows\System32” folder. 
• The users of the client computers must be logged on to the domain and have administrator 

privileges. 
• The “File and Printer Sharing for Microsoft Networks” protocol must be enabled on the client 

computers. 
• Windows Installer must be installed on the client computers. 
 
To install NTRadmin automatically 
1. In the Tools tab, choose Installation > Automatic Installation. 
2. Choose New Deployment. 
3. Enter a name and description for the installation and click Next. 
4. Enter and confirm a computer password that has a minimum of eight characters and click 

Next. 
When you need to start a remote control or file transfer session, you must enter the 
computer password. 

5. To download the installation file, click NTRadmin Installer Download and save it to a 
folder on your hard disk. 

6. Click Next.  
7. Select a network provider from the list and then select a domain that contains the 

computers on which you want to install NTRadmin. Depending on the configuration of your 
network, it may take a few minutes to display the list of computers in the domain. 

8. Select the computers on which you want to install NTRadmin. 
9. Select the computers that require user authorization when starting a remote control session. 
10. Select the installation file you downloaded in step 5 and click Install NTRadmin. 
 

Manual Installation 
If you want to use NTRadmin to administer computers that are not on your LAN, you choose to 
install NTRadmin manually. To do so, you or a user of the client computer must run the pre-
configured installation program and manually confirm each step. To easily distribute the 
installation file to your users, you can send an e-mail directly from NTRadmin to your users.  
The e-mail contains a link, which your computer users must click to download the installation 
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file. Alternatively, you can download the installation file and distribute it to your client computers 
using any method you choose, such as copying it from a USB memory key or a file server.   
 
To install NTRadmin manually 
1. In the Tools tab, choose Installation > Manual Installation. 
2. Choose New Link. 
3. Enter and confirm a computer password that contains at least eight characters. 
4. Enter the following additional information: 

• Name of the installation 
• Maximum number of installations allowed from the link 
• Computer group 
• Expiry date for the link. 

5. Select whether you want to send a link to the installation file or download the installation file 
to your computer. 
• If you choose to send an e-mail, enter the recipient e-mail addresses, and if you want, 

additional comments. To send the e-mail, click Next. 
• If you choose to download the installation file, click Next and save the installation file to 

a folder on your hard disk. 
 
Once NTRadmin is installed on your client computers, you can start administering them 
remotely.  
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Administering Your Network Remotely 
To remotely administer your network, you should first select the 'Computers' tab from the 
navigation bar then click on either the 'Computers' heading or on the name of one of the 
computers in the list.  Both actions open a new tab called 'Computers' in the main application 
window. 
 
This new tab contains a more detailed list of your computers.  Each computer in this new list 
has a checkbox beside its name and, if you opened this tab by clicking on the name of a 
computer within the list in the navigation bar, the checkbox for that computer will be checked 
automatically. 
 
Above the list of computers is a 'List of Groups' dropdown.  For more information on using 
groups, see “Organizing your Computers into Groups” on page 19. 
 
In the 'Tools' menu, you will see a list of available remote administration options. As remote 
administration tasks must be launched on one or more computers, most of these options are 
inactive until you have selected at least one computer (by checking the checkbox next to its 
name).  You can select as many computers as you like, and also have the option of selecting or 
deselecting every computer in the list by clicking on the 'Select/Deselect all computers' tool. 
 
Once you've selected the computers that you want to remotely administer, click on the required 
administration task.  There are eight different remote administration options available: 
• 'Wake-on-LAN' (see “Wake-on-LAN” on page 16) 
• 'Shut down computer' (see” Shut down computer” on page 16) 
• 'Remote Control' (see “Remote Control” on page 16) 
• 'File Transfer' (see “File Transfer” on page 29) 
• 'Launch Bots' (see “Launching Bots” on page 27) 
• 'Group Management' (see “Organizing your Computers into Groups” on page 19) 
• 'Move computers' (see “Adding or Moving Computers to a Group” on page 19) 
• 'Uninstall NTRadmin' (see “Uninstalling NTRadmin” on page 17) 
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SECTION 2 
Remote Network Administration with 

NTRadmin 
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Basic Remote Administration Tasks 
You can access the following options by clicking on the Computers heading of the Computers 
tab of the navigation bar. 
 

Wake-on-LAN 
The wake-on-LAN feature allows you to remotely boot any computer that's configured for wake-
on-LAN. Computers that support this option continue to listen to network traffic even when 
they're switched off, and will boot themselves automatically if they receive the magic packet that 
contains the boot instruction. Not all computers support wake-on-LAN, but NTRadmin doesn't 
know which do so you can send a wake-on-LAN instruction to any computer that is either 
switched off or on standby (in other words, any that is not already awake). 
 
To configure your computer for wake-on-LAN, you must change the settings for the network 
adapter or the BIOS. If you want to wake the computer from standby or sleep mode, you must 
configure the network adapter. If you want to wake your computer when it is switched off, you 
must configure the BIOS settings.  
 
To send a wake-on-LAN instruction, check the checkboxes alongside the names of the 
computers that you want to wake up, and click on the Wake-on-LAN option.  (You can select 
more than one computer at a time, but the 'Wake-on-LAN' option will be disabled if one or more 
of the selected computers is already on.)  Click on the OK button to confirm the action and 
NTRadmin will tell you whether or not the action has been successful. 
 

Shut down computer 
With the Shut down computer option you can remotely shut down any computer that is 
currently on. Check the checkboxes alongside the names of the computers that you want to 
shut down, and click on the Shut down computer option. (You can select more than one 
computer at a time, but the 'Shut down computer' option will be disabled if one or more of the 
selected computers is already switched off or on standby.) Click on the 'OK' button to confirm 
the action and NTRadmin will tell you whether or not the action has been successful. 
 

Remote Control 
With the 'Remote Control' option you can connect to a remote computer in order to use the 
computer as though you were sat in front of it, or to observe what that computer's user is doing. 
 

Starting a Remote Control Session 
Check the checkbox alongside the name of the computer that you want to remotely control, and 
click on the 'Remote Control' option. (You cannot start a remote control session with more than 
one computer at the same time.) You will now see the remote control options. 
 
First, select the type of remote control that you want to have. Choose 'Observer mode only' if 
you just want to observe the computer's user, or 'Remotely control a computer' if you want to 
be able to fully interact with the computer. 
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Second, you can select the 'Number of colors' that should be used by the remote control 
window.  The default is to use 256 colors, but you also have the option of '2 colors', '16 colors', 
'65536 colors', or 'True color'. The fewer colors you use, you faster the connection will be. 
 
Third, you can choose whether to 'Open Remote Control in a New Window' (if not, it will be 
opened in the main application window), whether to 'Block Keyboard and Mouse' of the user 
of the remote computer (so that they can't use either during the remote control session), and 
whether to 'Hide Screen' (so that your actions on the remote computer are not shown on its 
display). 
 
Finally, click on the 'OK' button to confirm the action and the remote control session will begin. 
 

Controlling a Remote Control Session 
When you begin a remote-control session, you will see the remote computer's desktop in your 
remote-control window and if you selected the 'Remotely control a computer' option, you will be 
able to use it as though you were using your own computer. 
 
You will also see in the remote-control window a menu of remote-control options.  The options 
on this menu allow you to configure your remote-control session by changing, for example, the 
screen resolution or the number of colors used by the display.  There is also an option on this 
menu for closing the session. 
 

Uninstalling NTRadmin 
The 'Uninstall NTRadmin' option allows you to remove the NTRadmin client from any computer 
on which you've installed it and to therefore remove it from NTRadmin's list of computers. 
 
Check the checkboxes alongside the names of the computers from which you want to uninstall 
NTRadmin, and click on the 'Uninstall NTRadmin' option.  Click on the 'OK' button to confirm 
the action and NTRadmin will tell you whether the uninstallation has been successful.
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Working with Favorites 
You can quickly access computers and frequently-used tools by adding them to your list of 
favorites. 
 
To add a computer to your favorites 
• In the computer list, right-click the computer name of the computer you want to add and 

choose Add to My Favorites. 
 
To add a tool to your favorites 
• In the tools menu, right-click the tool you want to add and choose Add to My Favorites. 
 
In addition to adding computers to your favorites, you can also add the URL of a webpage on 
the Internet or a local intranet, such as http://www.ntradmin.com. 
 
To add a URL to your favorites 
1. In the tools menu, right-click My Favorites. 
2. Enter a name and the URL for the webpage. 
3. To save the entry, click OK. To cancel, click Cancel. 
 
To delete a computer or URL from your favorites 
1. In the tools menu, expand the list of favorites. 
2. Right-click the entry you want to remove, and choose Delete from My Favorites. 
 
Note: If you want to use NTRadmin with a pocket PC, you must add the computers you want to 
administer to your favorites. Only computers that appear in your favorites are accessible from a 
pocket PC. 
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Organizing your Computers into Groups 

NTRadmin gives you the opportunity to organize your list of computers into as many groups as 
you wish.  You may find this convenient if, for instance, you need to perform department-
specific administrative tasks as, in that case, you could create a group for each department.  
This would give you a quick-and-easy way in which to identify and select the computers from 
within each department. 
 
You can access the options that relate to the creation and management of groups by clicking on 
the 'Computers' heading of the 'Computers' tab of the navigation bar. 
 
The existing groups are given in the 'List of Groups' dropdown.  By default, the list contains 
two entries – 'No group' and 'All Computers' – and these can neither be renamed nor deleted.  
You can't directly change the members of these two groups as the 'No group' group contains 
any computer that has not been explicitly assigned to one of the groups that you've created, and 
the 'All Computers' group includes every computer in the list.  Groups that you create will also 
be shown as part of the list of computers in the navigation bar. 
 

Creating a New Group 
To create a new group, simply click on the 'Group Management' option, specify the 'Group 
Name' and 'Group Description' and click on the 'OK' button.  Try to give the group a 
meaningful name and description in order to be able to easily identify it in the future. 
 
Your new group will now appear both in the 'List of Groups' dropdown and as part of the list of 
computers in the navigation bar.   
  

Adding or Moving Computers to a Group 
Computers can only be members of one group, so if you want to add a computer to a new 
group, you have to move it from the group that it's currently in.  As, by default, every computer is 
a member of the 'No group' group, adding unassigned computers to a group means moving 
them from the 'No group' group.  This means that adding and moving computers are essentially 
identical actions. 
 
To add computers to a group first select them from the list by checking the checkboxes next to 
their names.  Now click on the 'Move computers' option and select the group that you want to 
'Move selected computers to'.  Click on the 'OK' button and the computers that you've chosen 
to move will both disappear from the list and move to within the chosen group in the list of 
computers in the navigation bar. 
 
To move computers to a different group, first select their current group from the 'List of Groups' 
dropdown, or click on either the name of the group or the name of one of its members from the 
list of computers in the navigation bar.  The members of the chosen group will now be displayed 
in the list of computers and if got there by clicking on the name of a computer from the list in the 
navigation bar, the checkbox for that computer will be checked automatically.  The process of 
moving the computers to their new group is now the same as that for adding unassigned 
computers to a group: select the computers that you want to move (by checking the checkboxes 
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next to their names), click on the 'Move computers' option, select the group that you want to 
'Move selected computers to' and click on the 'OK' button. 
 

Deleting or Editing a Group 
To delete or edit a group, first select it from the 'List of Groups' dropdown, or click on either the 
name of the group or the name of one of its members from the list of computers in the 
navigation bar.  Now click on the 'Group Management' option, and you will see three group 
management options: 
• Add Group 
• Edit Group Name 
• Delete Group 
 
Select the 'Edit Group Name' option and the name of the group will be entered into the 'Group 
Name' field.  Edit the text and click on the 'OK' button to change the name. 
 
To delete the group, select the 'Delete Group' option and click on the 'OK' button.  Any 
computers that are members of this group will be reassigned to the 'No group' group. 
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Working with Jobs 
With NTRadmin, you can save tasks as jobs.  A job is a combination of an action and the 
computer or computers on which you want to launch it.  Jobs can save you a lot of time 
because you can save tasks that you launch often in order to be able to more easily repeat 
them in the future. 
 

Creating, Managing and Executing Jobs 
The options related to creating, managing and executing jobs are grouped below the 'Jobs' 
heading of the 'Tools' tab of the navigation bar.  Click on the 'Job List' option to see the list 
(initially empty) of existing jobs.  Once you've created some jobs, you'll be able to use the 'View' 
dropdown to view 'All Jobs', just 'Scheduled Jobs', or just 'Launched Jobs'.  The list of 'Tools' 
gives you six options: 
• Launch Job 
• Edit Job 
• New Job 
• Duplicate Job 
• Stop Job 
• Delete Job 
 
Only 'New Job' is initially active as the other five options must act on a job or jobs and are 
therefore only active when you've selected (by checking the checkboxes next to their names) a 
job or jobs from the list. 
 
Creating a New Job 
To create a new job, first click on the 'New Job' option and specify your new job's 'Name' and 
'Description'.  Try to give it a meaningful name and description in order to be able to easily 
identify it in the future.  Confirm these details by clicking on the 'Next >>' button. 
 
Now you can assign to your job the Bots that you want it to launch.  You can choose these Bots 
from those included with NTRadmin (see “Public Bots” on page 26) and those created by you 
(see “My Bots” on page 26).  The two sets are presented together in the List of available Bots.  
The lists are sorted alphabetically but listed separately so the 'Public Bots' are listed in full 
before the list of 'My Bots'. 
 
Click on the name of a Bot to see the Bot details.  The details given are: 
• Name: the Bot name. 
• Description: a brief description of the Bot's functionality. 
• Date creation: Bot creation date (set automatically when you create a new Bot). 
• Date modified: last Bot edit date (updated automatically when you edit a Bot). 
• Operating Systems: information on the Bot's compatibility with different operating systems. 
• Comments: comments added by the Bot author. 
• Parameters: values that must be passed to the Bot when you launch it.  Only some Bots 

take parameters (the 'Computer Model and Manufacturer' Bot, for example, does not take 
parameters whereas the 'Delete a File' Bot takes the name of the file that you want to 
delete). 
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• Bot: the Bot code.  This can be especially useful if you need to create a Bot that is similar to 
one that already exists as you can copy the code of that existing Bot and make the 
necessary changes. 

 
To assign a Bot to your job, double-click on its name in the 'List of available Bots' or click it 
once then click on the '>>' button.  This will add its name to the list of 'Launch Bots'.  To un-
assign a Bot from your job, double-click on its name in the list of 'Launch Bots' or click it once 
then click on the '<<' button.  When you launch your job (see “Launching a Job” on page 24), 
the assigned Bots will be launched in the order in which they are listed in the 'Launch Bots' 
select box.  You can change their order by highlighting the name of one of the Bots then using 
the 'Move Up' and 'Move Down' buttons to change its position relative to the others.  Confirm 
your list of assigned Bots by clicking on the 'Next >>' button. 
 
Next you need to set the Bot parameters.  Depending on the Bots that you've assigned to the 
job, there may be no parameters to set (in this case you will see the message “No parameters 
needed for the Bots on this job.”)  If you do need to set parameters, they will be grouped 
together beneath the names of the associated Bots.  You don't have to set a value for any 
optional parameters, but you do have to set them for mandatory parameters, which are 
identified by an asterisk (*) alongside their name. You will also have an opportunity to set values 
for the optional parameters when you launch the Bot (see “Launching a Job” on page 24).  
Confirm your parameter values by clicking on the 'Next >>' button. 
 
Next you need to choose the computers on which your job will be launched.  You will see a list 
of computers which, by default, will be of the members of the 'No group' group; however, should 
you need to, you can choose to show the members of the 'All Computers' group or those of one 
or your own groups by selecting the name of the group from the 'List of Groups' dropdown.  
You can only select computers from within a single group, so use the 'All Computers' group if 
the computers that you want to select are not all members of one of your own groups.  Select 
the computers that you want to assign to the job by checking the checkboxes next to their 
names. Confirm your selection by clicking on the 'Next >>' button. 
 
Finally you need to set the job scheduling options by first choosing one of the three job-
scheduling types. 
• Not Scheduled 

The job will only be run when launched manually (see “Launching a Job” on page 24). 
• Scheduled 

You will see additional job scheduling parameters, that will give you great control over when 
the job is first launched and if and when it repeats. 

• Launch delegated to user 
The job's launch will be delegated to each of the users to which you're assigning the Bot.  
This means that the option to launch the Bot will be added to the menu that the users see 
when they right-click on the NTRadmin icon in their system tray. 

 
Finally, click on the 'Save' button to create your job, which will then be available in the 'Job List'. 
 
Scheduling Your New Job 
When you schedule a job, there are three groups of options to set: 
• Occurs 
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• Daily Frequency 
• Duration 
 
Setting How Often the Job 'Occurs' 
By setting the 'Occurs' options, you can choose the day or days on which you want your job to 
launch (for example, everyday, once a week, or once a month). 
 
You do this by choosing one of three different frequencies: 
• Daily 

If you choose to schedule a 'Daily' job, you can then choose to repeat the job every n days 
by entering a value for n into the textbox. 

• Weekly 
If you choose to schedule a 'Weekly' job, you can then choose to repeat the job every n 
weeks (where n is a value that you enter into the textbox and can also check the 
checkboxes of the days of the week (Monday to Sunday) on which you want the job to be 
launched. 

• Monthly 
If you choose to schedule a 'Monthly' job, you can then choose to repeat the job on the nth 
day of every m months (where n and m) are the values that you enter into the two 
textboxes). 

 
Setting the 'Daily Frequency' of a Job 
By setting the 'Daily Frequency' options, you can set the frequency with which the job will run on 
a given day (for example, once only, every hour, or every four hours). 
 
You do this by choosing one of two different daily frequencies: 
• Occurs once at 

Choose this option if you want your job to run once only at a time of your choosing.  Set this 
time by specifying its hour and minute. 

• Occurs every 
Choose this option if you want your job to repeat every n hours or minutes (where n is a 
value that you enter into the textbox and 'Hour(s)' or 'Minute(s)' are the options in the 
dropdown menu). 

 
You can also set a period of the day during with your job should repeat.  You can do this by 
setting the period's 'Starting at' and 'Ending at' times.  This allows you, for instance, to 
schedule your job to be launched every hour but only between 9 a.m. and 7 p.m. 
 
Setting the 'Duration' of a Job's Schedule 
By setting the 'Duration' options you can set the period during which the schedule will be in 
force. 
 
First, set the 'Start date' – the first date on which the job will be permitted to run.  Then, set 
either the 'End date' – the final date on which the job will be permitted to run – or choose the 
'No end date' option to let the job continue to run until you de-activate it. 
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Duplicating an Existing Job 
If you need to create a new job that's similar to one that you've already created, you may find it 
easier to duplicate the job instead of creating a new one.  You can do this by selecting the job 
that you want to duplicate (by checking the checkbox next to its name) and clicking on the 
'Duplicate Job' option.  Once the job has been duplicated, you can change its name and any of 
its properties by editing it. 
 

Editing a Job 
To edit a job, select the job that you want to edit (by checking the checkbox next to its name) 
and click on the 'Edit Job' option. 
 
You will now see the job details in a new tab in the main application window.  There are six 
options listed under the 'Tools' heading: 
• View job details 
• Edit name and description 
• Assign Bots 
• Edit parameters 
• Assign computers 
• Scheduling 
 
'View job details' is the option selected by default.  The other five options allow you to revisit the 
stages of the job creation process.  The only difference here is that the stages as treated as 
separate edits, so when you finish, for example, assigning Bots to your job, you will return to the 
'View job details' screen and not, as would be the case if creating a new job, the 'Edit 
parameters' screen. 
 

Deleting a Job 
To delete a job, select the job or jobs that you want to delete (by checking the checkboxes next 
to their names) and click on the 'Delete Job' option. 
 
You cannot delete jobs that are currently scheduled or delegated.  To delete these jobs you 
must first stop them (see “Stopping a Job” on page 25). 
 

Launching a Job 
To launch a job, select the job or jobs that you want to launch (by checking the checkbox next to 
its name) and click on the 'Launch Job' option. 
 
If you launch a scheduled job, you enable its schedule; if you launch a job that is delegated to 
the user, you enable the Bot on the user's NTRadmin menu; and if you launch a job that is 
neither scheduled nor delegated, it will be launched in that moment. 
 
Every time that you launch a job, NTRadmin creates a report on the job event (see “Job 
Reporting” below). 
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Stopping a Job 
To stop a job, select the job or jobs that you want to stop (by checking the checkboxes next to 
their names) and click on the 'Stop Job' option. 
  
You can only stop jobs that are both currently launched and are either scheduled or delegated 
to the user. 
 

Job Reporting 
Every time that a job is launched, NTRadmin records the event along with useful information 
such as the computers on which it was launched and whether it was launched successfully. 
 
You can see the job reports by clicking on the 'Job Reporting' option below the 'Jobs' heading 
of the 'Tools' tab of the navigation bar.  This will open up a new tab in the main application 
window and in this you will see a list (which will be empty until you've launched your first job) of 
all of the job events (occasions on which your jobs have been launched) so far. The list shows 
the 'Job Name' and the date and time ('Launch Date') on which the job event occurred. The 
'View' dropdown menu lists the names of all jobs that have been launched and by choosing one 
of the jobs from the menu you can filter the list of job events so that it only includes the events 
for that job. Click on the radio button beside the name of a job in order to see the report on that 
job event. The report includes: 
• Job Name: the name of the job. 
• Launch Date: the date and time on which the job event occurred. 
• Bots: the names of any Bots that were launched as part of the job. 
• Computers: the computers on which the job was launched. 
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Working with Bots 
With NTRadmin, you can write Bots that you will then be able to launch on your network's 
computers.  Bots allow you to reduce a complex series of actions to a single command and are 
especially useful when you need to repeat those actions on all of the computers across your 
network. 
 
The NTRadmin scripting engine allows you to execute both VBScript and JavaScript code.  You 
can also execute Windows Scripting Host (WSH) scripts in remote computers by using the 
wscript.exe or cscript.exe engines. 
 
There are many Bots (Public Bots) included as standard with NTRadmin, but you can also 
create your own (My Bots). 
 
Bots can be used within jobs (see “Working with Jobs” on page 21) or launched on your network 
computers at the moment that you wish (see “Launching Bots” on page 27). 
 

Public Bots (NTRadmin Standard Bots) 
To see NTRadmin public Bots, click on the Public Bots option from the Tools tab of the 
navigation bar.  This can be found below the Bot Library subheading of Jobs heading.  
Clicking on this option will open a new tab in the main application window and in that tab you 
will see a list of the Bots that are currently available. 
 
By clicking on the radio button beside a Bot's name you can see that Bot's details: 
• Name: the Bot's name. 
• Description: a brief description of the Bot's functionality. 
• Operating Systems: information on the Bot's compatibility with different operating systems. 
• Comments: comments added by the Bot author. 
• Parameters: values that must be passed to the Bot when you launch it.  Only some Bots 

take parameters (the 'Computer Model and Manufacturer' Bot, for example, does not take 
parameters whereas the 'Delete a File' Bot takes the name of the file that you want to 
delete). 

• Bot: the Bot code. 
 
Seeing the details of NTRadmin public Bot can be especially useful when you need to create 
your own Bot as, if there is already a public Bot that does something similar, you can copy its 
details and use them as the basis for your Bot.  
 

My Bots (Creating and Managing Your Own Bots) 
To see the options related to the creation and execution of your own Bot, click on the My Bots 
option from the Tools tab of the navigation bar. This can be found below the Bot Library 
subheading of Jobs heading.  Clicking on this option will open a new tab in the main application 
window and you will see in that tab a list (initially empty) of the Bots that you've created along 
with a list of five options: 
• New Bot 
• Edit Bot 



 

 Page 27 of 48NTRadmin User Manual Nov 2007

• Delete Bot 
• Publish Bot 
• Bot Tutorial 

Opens the NTRadmin Bot Tutorial (a PDF file), which offers more detailed information on 
creating your own Bots. 

 

Creating a New Bot 
To create a new Bot, first click on the New Bot option and you will see a new tab in the main 
application window.  In this tab you will be able to enter the details of your new Bot: 
• Bot Name: the name of the Bot. 
• Description: A brief description of the Bot functionality. 
• Comments: Any further comments on the use of the Bot. 
• Bot: The Bot code (as VBScript or JavaScript, for example). 
 
Only 'Bot Name' and ‘Bot’ are compulsory, but it is good practice to describe what each Bot 
does and to comment on how it works as such information will be useful in the future when you 
(or another user) want to identify or launch one of the Bots in the future. 
 
Once you've finished entering the information, click on the OK button. 
 

Editing a Bot 
To edit a Bot, select the Bot that you want to edit (by checking the checkbox next to its name) 
and click on the Edit Bot option.  This will open up a new tab in which you will be able to edit 
the four fields that you set when your created the Bot. 
 

Deleting a Bot 
To delete a Bot, select the Bot that you want to delete (by checking the checkbox next to its 
name) and click on the Delete Bot option. 
 

Publishing a Bot 
You may like to publish some of the Bots that you've created if you think that they'll be useful to 
other users. Any Bots that you publish will appear in the NTRadmin list of public Bots. You can 
request that a Bot be published by checking the checkbox next to its name and clicking on the 
Publish Bot option. The final decision on whether to publish your Bot will be made by the 
NTRadmin team. 
 

Launching Bots 
You can launch Bots by clicking on the Computers heading of the Computers tab of the 
navigation bar. By clicking on the Launch Bots option, you will see a list of all of the Bots that 
are currently available.  This list displays the Bot name, description and source, where the 
source is either 'Public' (for public Bots) or 'Private' (for your own Bots).  The list is sorted 
alphabetically by Bot name but of higher priority is the Bot source, which means that all public 
Bots appear before the private ones. 
 



 

 Page 28 of 48NTRadmin User Manual Nov 2007

To launch a Bot, click on the radio button beside that Bot's name and click on the OK button.  
You will then be asked to enter values for any parameters that are taken by the Bot.  Once 
you've finished entering these values, click on the Launch Bot button. 
 
Every time that you launch a Bot, NTRadmin creates a report on the Bot event. 
 
If your Bot creates messages, these will be visible in the 'Messages' section.  
 

Bot Reporting 
Every time that a Bot is launched (whether in isolation or as part of a job), NTRadmin records 
the event along with useful information such as the computers on which it was launched and 
whether it was launched successfully. 
 
You can see the Bot reports by clicking on the Reporting option below the Jobs heading of the 
Tools tab of the navigation bar. This will open up a new tab in the main application window and 
in this you will see a list (which will be empty until you've launched your first Bot) of all of the Bot 
events (occasions on which your Bots have been launched) so far. The list shows the 'Bot 
Name', the computer on which the Bot was run ('Computer name'), that computer's operating 
system ('OS Version') and the date and time ('Launch date') on which the Bot event occurred.  If 
you have launched a Bot on more than one computer at the same time, there will be a separate 
Bot event for each computer. 
 
The 'View' dropdown menus list the names of all Bots that have been launched, the names of 
all of the computers on which you have launched Bots, and the operating systems of the 
computers on which you have launched Bots.  You can filter the list of Bot events by choosing 
options from one or more of those menus and clicking on the 'Apply filter' button.  You can click 
on the 'Reset filter' button to return to the full list of Bot events. 
 
Click on the radio button beside the name of a Bot in order to see the report on that Bot event.  
The report includes: 
• Bot Name: the name of the Bot. 
• Computer name: the computer on which the Bot was launched. 
• OS Version: the operating system of the computer on which the Bot was launched. 
• Message: the message created by the Bot (using the 'MESSAGE' variable). 
• Exit code: the Bot’s exit code (defined by the Bot author and used to determine whether the 

Bot was launched successfully). 
• Launch Date: the date and time on which the Bot event occurred. 
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File Transfer 
You can transfer files to the computers on your network by clicking on the 'Computers' heading 
of the 'Computers' tab of the navigation bar.  Select the computer to which you want to transfer 
a file (by checking the checkbox next to its name) and click on the 'File Transfer' option. 
 
You will now see a new window into which you must enter the password that you specified 
when you created the NTRadmin Installer that you used when installing NTRadmin onto the 
selected computer. 
 
You will now see the 'File Transfer' window in which you can browse for files on both your own 
and the remote computer. You can transfer files between the two computers by simply 
dragging-and-dropping the files between the two windows. 
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File Management 
NTRadmin gives you the option to upload and organize files that you want to distribute to your 
network.  This not only makes it easier to distribute those files, but also gives you easy ongoing 
access to them – making it easier to find and distribute them as you add new computers to your 
network. 
 
Once you've uploaded files to the NTRadmin server, you can distribute them to your network by 
using Bots. 
 
You can see the options relating to file management by clicking on the 'File Management' 
option of the 'Tools' tab of the navigation bar.  This opens up a new tab in the main application 
window and in this tab you will see a list (initially empty) of the files and folders that you 
currently have on the NTRadmin server.  Once you've imported some files and folders, this list 
will show you the file or folder name, type (file or folder), size (in kilobytes) and creation (upload) 
date. 
 
Above this list are the current path, the total capacity available to you on the NTRadmin server 
and the total capacity currently unused. 
 
Above this are the seven file management options: 
• Up One Level 
• New Folder 
• Import 
• Rename 
• Move 
• Download 
• Delete 
 
Only 'New Folder' and 'Import' are initially active as the other five options must act on a file or 
folder and are therefore only active when you've selected (by checking the checkboxes next to 
their names) a file or folder from the list. 
 

Importing Files 
You add files to NTRadmin by importing them to the NTRadmin server.  To import a file, first 
click on the 'Import' button and you will see the import file screen.  Click on the 'Browse…' 
button and you will open a standard file browser.  Browse to the file that you want to import and 
hit on the 'Send' button to upload it.  You will now see your file in the list of files and folders. 
 

Downloading Files 
You can copy files from the NTRadmin server to your own file system by downloading them.  To 
download a file, first select the file or files that you want to download (by checking the 
checkboxes next to their names) and click on the 'Download' option.  (As it is not possible to 
download folders, this option will remain disabled if your selection includes one or more folders.)  
This will open a standard file download browser through which you will be able to select the 
location to which you want to save the file. 
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Creating Folders 
As with any file system, folders can help you to better organize your files, and NTRadmin also 
offers you this capability. To create a folder, click on the 'New Folder' option, enter the folder 
name, then click on the 'Send' button. You will now see your folder in the list of files and folders. 
 

Navigating the List of Files and Folders 
The list of files and folders can be navigated in ways familiar from other systems. By allowing 
you to import files and create folders within folders, NTRadmin gives you the power to create 
the file structures of the complexity that you require. 
 
To navigate into a folder, click on its name. The contents of the folder will be displayed in the list 
and the current path updated.  The current path is updated as you browse and, as each part of 
the path is clickable, it gives you an easy way to return to the higher levels. You can also click 
on the button to move 'Up One Level'. 
 

Renaming Files and Folders 
To rename a file or folder, first select the file or folder that you want to rename (by checking the 
checkbox next to its name), click on the 'Rename' option, enter the new name and click on the 
'Send' button.  (As it is only possible to rename one file or folder at a time, this option will remain 
disabled if you select more than one file or folder.) 
 

Moving Files and Folders 
To move files and folders to another part of your file structure, first select the items that you 
want to move (by checking the checkboxes next to their names).  Now click on the 'Move' option 
and a new window will open in which you will be able to browse your file structure.  Select the 
folder into which you want to move the selected items and click on the 'OK' button.  You will be 
warned if the action is not possible (for instance, because you are trying to move a file to a 
folder that already contains a file that has the same name). 
 

Deleting Files and Folders 
To delete files and folders, simply select the items that you want to delete (by checking the 
checkboxes next to their names) and click on the 'Delete' option.  You will be prompted to 
confirm that you want to delete the selected items. 
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SECTION 3 
Additional Features of NTRadmin 
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Messages 
To see the NTRadmin messages click on the 'Messages' option of the 'Tools' tab of the 
navigation bar.  This will open up a new tab in the main application window and you will be able 
to use the 'List of types of messages' dropdown menu to select from four different types of 
message: 
 
• Scripts: Scripts generate messages when they use the 'MESSAGE' variable in lines such 

as 'MESSAGE = “Script completed successfully.”' The message set is recorded along with 
its creation time and the computer on which the script was launched. 

• Users: When users have NTRadmin installed on their computers, they have an NTRadmin 
icon in their system trays and can access a menu of options by right-clicking on this icon. 
One of the options in this menu is 'Help Request' and any requests (user messages) that 
they send can be seen here. 

• Alerts: Here you can see any automated system alert messages. 
• NTRglobal: Here you can see messages sent by NTRglobal. 

 
By clicking on a message you can see more details and can change its priority and status, and 
add comments. 
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The NTRadmin Community 
You can keep up-to-date with the latest developments to NTRadmin and share ideas with other 
NTRadmin users via the NTRadmin Community.  The community consists of a series of forums 
through which the NTRadmin development team and other NTRadmin users can share useful 
information and ask and answer questions.  All NTRadmin users have access to read and add 
to these forums. 
 
Most forums are interactive (meaning you can add new messages and reply to others), but 
some are read-only. 
 
The forums of the NTRadmin community are grouped below the 'Community' heading of the 
'Tools' tab of the navigation bar. They are further sub-grouped into 'Categories' and 
'Development of Bots'.  Clicking on one of these sub-group headings will open a new tab in the 
main application window in which you will see a list of the forums along with a brief description 
of each one. At the top of the screen is a 'Text Search' textbox and a 'Search' button with which 
you can search this group of forums. At the bottom of the screen is the 'Add a Category' form 
through which you can add new forums. To do this, simply specify the 'Category name' and 
'Category Description' and press the 'Add a Category' button.  Any forums that you create will 
be visible to all other users of NTRadmin. You can delete your forums or change their names 
and descriptions by clicking on the 'Delete' or 'Modify' links on the right of the screen. If you 
delete a forum, all of the messages within that forum will also be deleted. 
 
To view a forum, click on the name of a forum (either from the list in the navigation bar or from 
the list in its group page) and a new tab will be opened in the main application window. 
 

Forums: the 'Categories' Sub-group 
The Categories sub-group contains the following forums. 
• News: News on NTRadmin and NTRglobal. This is a read-only forum. 
• Administrator Forums: A place for administrators to share their ideas and opinions on 

NTRadmin. 
• Technical Support: Post your questions about NTRadmin. 
• Suggestions: Suggest improvements and changes to NTRadmin. 
• Tips: Read and suggest tips on how to get the most out of NTRadmin. 

 

Forums: the 'Development of Bots' Sub-group 
The 'Development of Bots' sub-group contains the following forums. 
• Technical Documentation: Documentation and other useful information for administrators. 
• New Bot Proposals: Propose Bots that you would like to see added to NTRadmin public 

Bots. 
• Technical Support: Ask questions about the use of Bots within NTRadmin. 
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Administration 
The key distinction in NTRadmin is between administrators (those that will use NTRadmin for 
remotely administering their network) and users (those that have NTRadmin installed on their 
computers); however, administrators can also delegate administration tasks by creating 
additional administrators and sharing computers with them. 
 
Features related to the management of administrators and to the sharing of computers are 
grouped below the 'Settings' heading of the 'Tools' tab of the navigation bar.  There are three 
options: 
• Management of Administrators 
• Share Computers 
• RC Configuration 
 

Creation and Management of Administrators 
If you have more than one administrator license for NTRadmin, you can create an additional 
administrator for each of those additional administrator licenses. 
 
If you click on the 'Management of Administrators' option, you will see information about you 
NTRadmin account including the number of licenses (the 'Administrators' value) that you 
currently have. 
 
You can create a new user by clicking on the 'New administrator' option.  This will open up a 
new screen in which you must specify the following compulsory information about your new 
administrator: 
• Display name 
• Name 
• Surname 
• Language 
• E-mail 
• Password 
• Re-type password 
• Enabled 
 
Once the new administrator has been created and enabled, they will be able to log on to and 
start using NTRadmin. 
 
You can edit any of the administrator's details by selecting them from the list (by checking the 
checkbox beside their name) and clicking on the 'Edit administrator' option. 
 

Sharing Computers with Other Administrators 
By selecting computers from the list (by checking the checkboxes next to their names) and 
clicking on the 'Share' option, you can choose the other administrators with which you want to 
share those selected computers.  When you share computers with other administrators, those 
administrators will see the shared computers in their list and will be able to remotely administer 
those computers as though they themselves had deployed the NTRadmin installer. 
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To un-share computers (thereby removing them from the lists of computers that are seen by 
other administrators), select the computers that you want to un-share (by checking the 
checkboxes next to their names) and click on the 'Unshare' option. 
 

Configuring Remote Control Permissions 
NTRadmin allows you to configure permissions for starting a remote control (RC) session on a 
client computer. If you want to require authorization from the user before starting a remote 
control session, you can specify that authorization is required. Otherwise, the default setting is 
not to require user authorization. For example, if your company’s privacy policy requires 
authorization from the user of a computer before a remote control session is started, you can 
enable authorization. However, when it is likely that a user would not be able to confirm the start 
of a remote control session, for example on a server, you can turn off remote control 
authorization. 
  
When you configure the installation settings for NTRadmin on client computers, you can also 
specify whether or not you want to require user authorization for remote control sessions.  
 
To require user authorization 
1. In the tools menu, choose Settings > RC Configuration. 
2. Select the computers for which you want to require authorization. 

If you have added your computers to groups, you can select a group to reduce the number 
of computers displayed in the list. 

3. Choose Authorization Required. 
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SECTION 4 
Appendices 
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Appendix A: FAQs 
 

How big is the NTRadmin Installer? 
The exact size of the NTRadmin Installer depends on the settings that you use when creating it, 
but the current version is always smaller that 500 KB. 
 

How much bandwidth do I need to administer a computer with NTRadmin? 
You only need a negligible bandwidth to administer computers with NTRadmin.  Greater 
bandwidth would be an advantage if you wanted to transfer large files to remote machines, but, 
even then, there are no minimum bandwidth requirements (transfers would just be faster if you 
had more bandwidth). 
 

Do I need to open firewalls in order to install NTRadmin? 
No. However, before you can do a remote deployment of NTRadmin, you do need to make sure 
that file sharing is enabled on that machine.  This is not necessary if you are going to do a local 
deployment. 
 
To enable file sharing you will need to first go to the ‘Windows Security Center’ (‘Start’ menu > 
‘Settings’ > ‘Control Panel’ > ‘Security Center’). 

 
Next click on the ‘Windows Firewall’ option and Windows will open a new dialog box.  Activate 
the ‘Exceptions’ tab and check the box for the ‘File and Printer Sharing’ option. 
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Once you have finished the remote deployment, you can disable ‘File and Printer Sharing’ on 
that machine. 
 

What permissions do I need to install NTRadmin? 
You must have Windows administrator rights on any computer on which you want to install 
NTRadmin. 
 

Will the user see any indication that NTRadmin has been installed on their 
computer? 
When NTRadmin has been installed on a computer, the user will see the NTRadmin icon in 
their system tray. 
 

 
 
Will the user be able to uninstall NTRadmin from their computer? 
No.  To uninstall NTRadmin, it is necessary to enter a password set by you, the administrator. 
 

How do I make a help request? 
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To make a help request, right-click on the NTRadmin icon (from your system tray) and select 
the ‘Help Request’ option from the popup menu. 
 

 
 
You will now see a new window from which you can make you help request.  Set a ‘Subject’ and 
‘Contents’ that describe your request then click on ‘Send Message’. 
 

 
 
How do I create a Bot? 
Click on the ‘My Bots’ option from the ‘Tools’ tab of the navigation strip that runs down the left-
hand side of the NTRadmin window. 
 
Now click on the ‘New Bot’ option from the ‘Tools’ menu of the new tab. 
 
You can find detailed help on writing bots in the NTRadmin Bot Creation Tutorial. 
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What options do I have when scheduling a job? 
There are three groups of options in the scheduler: ‘Occurs’, ‘Daily Frequency’ and ‘Duration’. 
 
By changing the ‘Occurs’ option, you can specify the day or days on which you want the job to 
run.  First, you can choose between ‘Daily’, ‘Weekly’ and ‘Monthly’ frequencies. 

 
If you choose to schedule ‘Daily’ jobs, you can then choose to repeat the job every n days by 
entering a value for n into the textbox. 
 
If you choose to schedule ‘Weekly’ tasks, you will have a different set of options. 

 
This time you can choose to repeat the job every n weeks (where n is a value that you enter into 
the textbox) and can also specify on which days of the week (Monday to Sunday) you want the 
job to be executed. 
 
If you choose to schedule ‘Monthly’ jobs, you will have a third set of options. 

 
Here you can schedule the job to run on the nth day of every m months (where n and m are the 
values that you enter into the two textboxes). 
  
After you have set the ‘Occurs’ options, you can move on to the ‘Daily Frequency’ options. 
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You can either set the job to occur once only at a time of your choosing (the ‘Occurs once at’ 
option), or you can choose the ‘Occurs every’ option and have the job repeat every n hours or 
minutes (where n is a value that you enter into the textbox).  You can also set a period of the 
day during with a job should repeat (for instance, if you want the job to be executed every hour 
from 9 a.m. to 7 p.m.).  You define this period by setting the period’s ‘Starting at’ and ‘Ending at’ 
times. 
 
After you have set the ‘Daily Frequency’ options, you can move on to the ‘Duration’ options. 
 

 
 
Here you can set the period during which the job will repeat.  You do this by setting a ‘Start 
date’ (the first date on which the job is permitted to run) and the ‘End date’ (the final date on 
which the job is permitted to run).  You can also choose to set ‘No end date’ if you want the job 
to continue to run until you de-activate it. 
 

Can I remotely administer a computer that is not in my network? 
Yes, you can remotely administer any computer that is connected to the Internet. 
 

What can I find in the forums? 
In the forums, you can: 
• Keep up-to-date with the latest news on NTRadmin and NTRglobal. 
• Exchange ideas with other administrators. 
• Ask questions to NTRadmin technical support staff. 
• Suggest improvements to NTRadmin. 
• Read tips on how to get the most out of NTRadmin. 
 
Also in the ‘Community’ section are: 
• Documentation of the NTRadmin Bots. 
• Details of newly-added Bots. 
• The chance to suggest any Bot that you would like see added to NTRadmin. 
• Technical support on the use of Bots. 
 

If I use the Silent NTRadmin Installer, will the user have to accept the installation? 
No.  If you use the Silent NTRadmin Installer, the user will not interact with the installation in any 
way (and, furthermore, the user will not see any indication that the installation is taking place). 
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Is it possible to deploy to more than one machine at a time? 
Yes.  When you deploy NTRadmin, you can choose to deploy to as many machines as you like 
within a single network. 
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Appendix B: Security Specifications 
 
NTRglobal guarantees that NTRadmin has: 
 
Physical Security (SaaS model) 
• Environmental security 
• Electrical security 
• Physical security 
• Architectural security 
 
Storage Areas 
The storage areas of the data warehouses typically have the following physical characteristics: 
• Technical Floor. 
• Fire Protection systems 
• Racks.  
• Network Cabling. 
 
Incident Management 
The monitoring system automatically feeds information into the Incident Management System: 
• Incident Resolution and escalation. 
• Incident Detection. 
 
System Backup 
To protect its customers and to ensure a rapid recovery in the event of a system failure, 
NTRglobal regularly backs up its systems and all of its customers’ valuable data. 
 
Software Certification 
NTRadmin is certified by Verisign. The Verisign certificate guarantees to users that they are 
using an original copy of NTRadmin – a copy supplied by NTRglobal, which has not been 
modified by any third party.  NTRglobal guarantees that the software is free of all viruses. 
 
Secure Connections 
NTRadmin uses standard ports to establish connections.  
 
Access Security 
For further security, Administrators also have the option of logging in to NTRadmin via a 128-bit 
Secure Socket Layer (SSL) connection. 
 
Data Encryption 
All of the standard algorithms used by NTRadmin have been validated by the official tests 
provided by the creators/owners of that algorithm.  
 
All sensitive or confidential information is encrypted before being sent.   
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Encrypted Storage: Confidential or sensitive data stored in the database are always 
encrypted. Stored conversations are only decrypted at the moment that the Administrator 
consults them. 
 
The Rijndael 256 Algorithm: NTRadmin uses the Rijndael 256 algorithm for encoding the 
connections of the remote control modules. This algorithm meets the requirements set by the 
Federal Information Processing Standard (FIPS.197) and can thus be used by US government 
organizations for protecting their sensitive data. 
 
Rijndael was created by the Belgian researchers Vincent Rijmen and Joan Daemen. It is a block 
encoder that operates using blocks and keys of variable length: 128, 192 or 256 bits.  
 
Attack Detection 
At the application level the company detects the following types of attack: 
• SQL injection 
• Cross-site scripting (XSS) 
• Hijacking 
• Flooding 
 
Blocking user access to NTRadmin: When an attack is detected, two types of block are applied: 
• Blocking IP address 
• Blocking user account 
 
SSL 
SSL is a cryptographic protocol that provides a secure connection across the Internet.  This 
enables the client and server applications to communicate in a way that prevents 
eavesdropping, tampering and message forgery. 
 
Security Processes 
 
Remote Control: To maintain a remote control session, NTRadmin sends and receives packets 
of information via a TCP connection, using a customised version of a generic protocol.  The 
protocol uses the 256-bit Rijndael algorithm to encrypt the information. 
 
Launching of Bots: We assure confidentiality for bots that are sent on the network. All bots are 
encrypted then sent to the client computer, where they are decrypted and launched. The used 
cryptographic algorithm is the AES 256. 
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Appendix C: Wake-On-LAN 
 
In order for you to remotely wake up or switch off a PC, that PC must have the Wake-on-LAN 
capability, meaning that the following has to be configured: 
• As most modern network cards do, the PC’s network card must support Wake On LAN. 
• From the network-card configuration-screen of the PC’s BIOS, enable the Wake on LAN 

functionality (the location of this will depend on the version of BIOS you have). 
• From the network card’s power-management configuration-screen, activate the option 

“allow this device to bring the computer out of standby” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A remote PC can be woken up in the following circumstances: 
• There is a PC that is switched on, has NTRadmin installed and is inside the same network 

as the PC that you want to wake up. 
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Appendix D: Pocket PC 
 
To start remote control with a Pocket PC, follow these steps (the steps are for an installation on 
Microsoft Windows Mobile 5): 
 
1) Turn on the Pocket PC. 
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2) Open Internet Explorer by clicking on the 'Internet Explorer' option from the 'Start' menu. 
 
3) Enter http://www.ntradmin.com/ or http://www.ntradmin.mobi/ into the address bar and click 
on the green arrow to open the URL. 
 
4) Once it has been detected that you are using a Pocket PC, NTRadmin will redirect you to the 
Pocket PC login page. Enter your user name and password and click on the 'Login' button. 
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5) You will now see one of the following screens: 
 
5.1) If this is the first time that you have entered, you will see a screen inviting you to download 
an installer. 
 

 
 
Click on the link and you will see a new window.  Click on 'Yes' to confirm that you want to 
download the NTRadmin cab file and install it on your Pocket PC.  You will then be redirected to 
the login screen (point 4 of this document). 
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5.2) Otherwise, you will see the list of your favorite computers. 
 

 
 
6) Click on the name of a computer to begin remote control of it. You will then be asked to enter 
the password assigned to that computer. 
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7) You will now see the computer's desktop within your Pocket PC. 
 

 
 
You can now interact with the remote computer as you would if you were using it directly. 
 
The mouse-emulation buttons allow you to modify the action taken on the remote computer 
when you touch the screen with your stylus.  There are four options, which, from left to right, 
are: (1) no action, (2) left click, (3) right click, and (4) double click.  This means that, for 
example, to double left-click you need to first press the double-click button (thereby activating a 
persistent double-click mode) then press the left-click button. 
 
In addition, the following options are available from the 'Options' menu: 
 

Options 
 

• 'View' submenu 
 

Here you can choose between viewing the remote desktop in 2, 16, 256 or 65536 colors.  
The fewer colors you choose, the faster will be the screen update. 
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You can also choose between various different desktop sizes.  If you select the option 'Real 
size', the remote desktop will be shown at its original size, with scrollbars displayed to allow 
you to access the desktop's full area.  Choose the 'Fit to screen' option if you want to see 
the whole of the remote desktop precisely fill your Pocket PC's screen.  Finally you can 
choose the 'Scale to width' or 'Scale to height' option to have the remote desktop scaled 
to precisely fit either the width of height of the Pocket PC's screen. 

 
You can also choose the 'Refresh' option to repaint the screen. 

 
• 'Actions' submenu 

 
By choosing the 'Ctrl+Alt+Sup' option you can send a 'Ctrl+Alt+Del' command to the 
remote computer. 

 
• 'Tools' submenu (currently inactive) 

 
The 'File Transfer' option allows you to transfer files between the remote computer and 
your Pocket PC. 

 
The 'Remote Diagnostics' option allows you to view information on the configuration of the 
remote computer. 

 
• 'Help' submenu 

 
By choosing the 'About' option you can view version and resource-usage information. 

 
• 'Minimize' option 

 
Minimize the remote-control window. 

 
• 'Exit' option 

 
End the remote control session. 

 

Zoom 
 
You can use the zoom controls to view more or less of the remote computer screen.   
 

Mini map 
 
If you are viewing your remote computer screen in real size, you can use the mini map to 
quickly move around the remote computer screen without having to scroll. The mini map shows 
you the full screen of the remote computer in a small area at the bottom of your Pocket PC. To 
view an area of the remote computer screen using the mini map, click anywhere inside the mini 
map – the corresponding area of the remote computer is displayed on your Pocket PC.  
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